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Important Information

Warranty
The National Instruments MXIbus boards and accessories are warranted against defects in materials and workmanship for a period of one year
from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment
that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF

NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR

DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY

THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire,
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

Trademarks
CVI™, LabVIEW™, MANTIS™, MITE™, National Instruments™, NI™, NI-488.2™, ni.com™, NI-DAQ™, NI-VISA™, NI-VXI™, TIC™,
and VXIpc™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only)
or Class B (for use in residential or commercial locations). Depending on where it is operated, this product could be subject to
restrictions in the FCC rules. (In Canada, the Department of Communications (DOC), of Industry Canada, regulates wireless
interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless products. By
examining the product you purchased, you can determine the FCC Class and therefore which of the two FCC/DOC Warnings
apply in the following sections. (Some products may not be labeled at all for FCC; if so, the reader should then assume these are
Class A devices.)

FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and undesired
operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations where FCC Class A
products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN,
or the FCC Class B compliance mark that appears as shown here on the right.

Consult the FCC web site http://www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions
in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and television reception.
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department
of Communications (DOC).

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate the
equipment under the FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Class B
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of
the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.



Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Readers in the European Union (EU) must refer to the Manufacturer’s Declaration of Conformity (DoC) for information**
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product except for
those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or where compliance is not
required as for electrically benign apparatus or cables.

To obtain the DoC for this product, click Declaration of Conformity at ni.com/hardref.nsf/. This web site lists the DoCs
by product family. Select the appropriate product family, followed by your product, and a link to the DoC appears in Adobe
Acrobat format. Click the Acrobat icon to download or read the DoC.

* Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c). Also available in
sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions for the user or
installer.
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About This Manual

This manual contains instructions for installing and configuring

the National Instruments PCI-based MXI-2 interface kit for

Windows 2000/NT/Me/98. This manual is meant to be used with the

MXI-2 Configuration Reference Manual.

Your kit contains either a VXI-MXI-2 or VME-MXI-2, which plugs into

your VXI or VME mainframe and links your computer to the VXIbus

or VMEbus, respectively. The kit also contains either a PCI-MXI-2

or a PXI-8320 interface board, which links your PCI-based or

PXI/CompactPCI computer to the MXIbus. Your software consists of the

NI-VXI bus interface software, which is fully VXIplug&play compliant,

and the NI-VISA API, which is the National Instruments implementation

of the VISA I/O software standard on which all VXIplug&play software

components are based.
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How to Use This Documentation Set

This getting started manual contains an overview of the MXI-2 hardware

and the NI-VXI software, guides you through setting up your kit, and helps

you get started with application development. You can also use this manual

as a reference for the hardware and software default settings and to find the

answers for commonly asked questions.

The MXI-2 Configuration Reference Manual contains information on

configuring, installing, and cabling your MXI-2 hardware. You need to use

this manual in conjunction with the getting started manual.

Getting Started
Manual

Installation and
Configuration

MXI-2 Configuration
Reference Manual

Change Hardware
Settings (Optional)

NI-VISA
User Manual

NI-VISA
Reference

NI-VXI (Optional)
and NI-VISA

Function Help,
Measurement &

Automation Explorer,
NI Spy, VISAIC

Use Online
Utilities:

NI-VXI
Online Help
(Optional)

NI-VXI
Reference
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When you have successfully set up your system, you can begin to develop

VXI applications. See Chapter 3, Developing Your Application, for

detailed info about using NI-VISA and NI-VXI to control your VXI

system.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to

pull down the File menu, select the Page Setup item, and select Options

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to

avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software,

such as menu items and dialog box options. Bold text also denotes

parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction

to a key concept. This font also denotes text that is a placeholder for a word

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the

keyboard, sections of code, programming examples, and syntax examples.

This font is also used for the proper names of disk drives, paths, directories,

programs, subprograms, subroutines, device names, functions, operations,

variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer

automatically prints to the screen. This font also emphasizes lines of code

that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value

that you must supply.
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Related Documentation

The following documents contain information that you may find helpful as

you read this manual:

• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile

Backplane Bus: VMEbus

• ANSI/IEEE Standard 1155-1993, IEEE VMEbus Extensions for

Instrumentation: VXIbus

• ANSI/VITA 1-1994, VME64

• CompactPCI Specification, Revision 2.0, PCI Industrial Computers

Manufacturers Group

• Multisystem Extension Interface Bus Specification, Version 2.0,

National Instruments Corporation

• PCI Local Bus Specification, Revision 2.1, PCI Special Interest Group

• PXI Specification, Revision 2.0, National Instruments Corporation

• VME-MXI-2 User Manual, National Instruments Corporation

• VXI-MXI-2 User Manual, National Instruments Corporation

• VXI-6, VXIbus Mainframe Extender Specification, Rev. 1.0,

VXIbus Consortium



© National Instruments Corporation 1-1 PCI-Based MXI-2 Interfaces for Windows 2000/NT/Me/98

1
Introduction

This chapter describes your MXI-2 interface kit, lists what you need to get

started, and includes a brief description of the hardware and software.

This manual uses the term VXI/VME-MXI-2 when information applies to

either the VXI-MXI-2 or the VME-MXI-2. This manual also uses the term

Windows 2000/NT/Me/98 when information applies to all supported

Windows operating systems.

The following flowchart shows where to turn for more details on

configuring and using the hardware and software.

How to Use This Manual

Notice that for hardware configuration, you should refer to the MXI-2

Configuration Reference Manual for a full description of how to configure

and install the MXI-2 boards and an overview of MXI-2 itself. Then return

to this manual for further information.

Yes No

Chapter 3 Develop Your Application

Using Hardware
Defaults?

Gather What You Need
to Get Started

Chapter 1

Install Hardware and NI-VXI
Software, Verify System,

Run Measurement & Automation 
Explorer (MAX) to Configure 

All Devices in System

Refer to Your MXI-2 Configuration
Reference Manual

Chapter 2
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What You Need to Get Started

You need the following items to set up your VXI or VME system:

❑ A PCI-based computer or PXI/CompactPCI chassis running

Windows 2000/NT/Me/98

❑ VXIbus or VMEbus mainframe

❑ PCI-MXI-2 or PXI-8320 interface board

❑ VXI-MXI-2, VXI-MXI-2/B, or VME-MXI-2 interface module

❑ MXI-2 cable

❑ National Instruments software media

PCI-Based MXI-2 Interface Kit Overview

The interface kits described in this manual link a PCI-based

computer or a PXI/CompactPCI chassis directly to the VXIbus or

VMEbus using the high-speed Multisystem eXtension Interface bus

(MXI-2). The MXI-2 kits, which include the NI-VXI software for

Windows 2000/NT/Me/98, are as follows:

• VXI-PCI8000, containing a PCI-MXI-2 and a C-size or B-size

VXI-MXI-2

• VXI-PXI8000, containing a PXI-8320 and a C-size or B-size

VXI-MXI-2

• VME-PCI8000, containing a PCI-MXI-2 and a VME-MXI-2

• VME-PXI8000, containing a PXI-8320 and a VME-MXI-2

A PCI-based computer equipped with a VXI-PCI8000 interface, or a

PXI/CompactPCI chassis equipped with a VXI-PXI8000 interface, can

function as a VXI Commander and Resource Manager. A PCI-based

computer equipped with a VME-PCI8000 interface, or a PXI/CompactPCI

chassis equipped with a VME-PXI8000, can function as a VMEbus master

and/or slave device. The MXI-2 interface kit makes your computer or

chassis behave as if it were plugged directly into the VXI/VME backplane

as an embedded CPU VXI/VME module.

The CD included with the kits contains software for Windows-based

computers.
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Hardware Description

The PCI-MXI-2 is a half-size, PCI-compatible plug-in circuit board that

plugs into one of the expansion slots in your PCI-based computer. The

PXI-8320 is a 3U-size, PXI/CompactPCI-compatible circuit board that

plugs into one of the peripheral slots in your PXI/CompactPCI chassis.

Both boards link your computer directly to the MXIbus and vice versa.

Because the PCI-MXI-2 and PXI-8320 use the same communication

register set that other VXIbus message-based devices use, other MXIbus

devices view your board as a VXIbus device. The PCI-MXI-2 and

PXI-8320 can also function as the MXIbus System Controller and can

terminate the MXIbus signals directly. In addition, you can have up to

16 MB of onboard DRAM on your board that can be shared with the

MXIbus and VXI/VMEbus and used as a dedicated data buffer.

The VXI-MXI-2 module is an extended-class, register-based VXIbus

device with optional VXIbus Slot 0 capability so that it can reside in any

slot in a C-size or D-size chassis. Optionally, you can use the

VXI-MXI-2/B, which can reside in any B-size VXIbus slot.

Note D-size VXI mainframes have connections for a P3 connector. The VXI-MXI-2,

however, does not have this connector and, if configured as a Slot 0 controller, cannot

provide the necessary control for VXI devices that need P3 support.

The VXI-MXI-2 uses address mapping to convert MXIbus cycles into

VXIbus cycles and vice versa. By connecting to the PCI-MXI-2 or

PXI-8320 board, the VXI-MXI-2 links the PCI bus or the PXI/CompactPCI

bus to the VXIbus. The VXI-MXI-2 can automatically determine whether

it is in VXI Slot 0 and/or if it is the MXIbus System Controller.

The VME-MXI-2 module is a single-slot, double-height VMEbus device

with optional VMEbus System Controller functions. It uses address

mapping to convert MXIbus cycles into VMEbus cycles and vice versa,

just like the VXI-MXI-2. By connecting to the PCI-MXI-2 or PXI-8320

board, the PCI bus or the PXI/CompactPCI bus is linked to the VMEbus.

The VME-MXI-2 can automatically determine if it is located in the first

slot of a VMEbus chassis and if it is the MXIbus System Controller.

Also, the VXI/VME-MXI-2 automatically terminates the MXIbus if

installed as the first or last device in the MXIbus. If installed in the middle

of the MXIbus, the VXI/VME-MXI-2 automatically disables MXIbus

termination. In addition, you can have up to 64 MB of onboard DRAM on
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the VXI/VME-MXI-2 module that either can be shared with the

VXI/VMEbus and MXIbus or used as a dedicated data buffer.

VME Users
When used with a VXI-MXI-2, VXI Resource Manager (Resman)

identifies and configures the VXI devices, including the VXI-MXI-2.

When used with a VME-MXI-2, Resman configures the VME-MXI-2 to

allow the PCI-MXI-2 or PXI-8320 to access devices in the VME chassis.

Resman does not configure VME devices. The VME specification does not

include the initialization and configuration procedures that the VXI

specification requires.

If you want to include VME devices in your system, you must enter

information about your VME devices using the Create Device Wizard in

Measurement & Automation Explorer (MAX). Resman can then properly

configure the various device-specific VME address spaces and VME

interrupt lines. Note that the VME-MXI-2 itself conforms to the VXIbus

register set and is therefore configured automatically by Resman.

For each address space in which your VME device has memory, you must

create a separate pseudo-device entry with a logical address between 256

and 511. For example, a VME device with memory in both A24 and A32

spaces would require two entries. You can also specify which interrupt

level(s) the device uses. Interrupt levels cannot be shared by VXI and VME

devices. After running Resman, you can access the VME device from

NI-VXI just as you would a VXI device, by specifying the address space

and the offset from the base at which you have configured it. NI-VISA

support for VME devices includes the register access operations (both

high-level and low-level) and the block move operations, as well as the

ability to receive interrupts.

Software Description

The NI-VXI bus interface software includes a Resource Manager, an

interactive configuration and troubleshooting program, a comprehensive

library of software routines for VXI/VME programming, a logging utility

you can use for debugging, and graphical interactive control programs for

interacting with your VXI system. You can use this software to seamlessly

program multiple-mainframe configurations and have software

compatibility across a variety of controller platforms.

NI-VISA is the native API for communicating with VXI/VME devices.

NI-VISA is the National Instruments implementation of the VISA I/O
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standard, which is a common interface to many types of instruments (such

as VXI, GPIB, PXI, Serial, TCP/IP, etc.). NI-VXI is optimized for use

through NI-VISA, and we recommend using NI-VISA to develop all new

VXI/VME applications.

To comply with VXIplug&play specifications, a VXI controller must

provide the VISA I/O driver library standardized by VXIplug&play. VISA

ensures that your controller can run all VXIplug&play-compatible software

now and in the future.

The NI-VISA software in this kit is compatible with the WIN95/GWIN95

and WINNT/GWINNT frameworks. With NI-VISA installed on your

computer, you can run any VXIplug&play software compatible with these

frameworks. This includes instrument drivers and executable soft front

panel software included with VXIplug&play-compatible instruments from

a variety of vendors.

Measurement & Automation Explorer (MAX) helps you configure your

VXI system. Use MAX to view your entire T&M system and configure

various components, whether they are VXI, GPIB, PXI, TCP/IP,

GPIB-VXI, or Serial devices. This utility not only takes the place of the

NI-VXI T&M Explorer utility, but it also adopts the functionality of the

NI-DAQ Configuration utility so you can configure National Instruments

DAQ products. You can also add VME devices to your system easily with

MAX and view them on a screen display along with the rest of your system.

MAX also features various options for running Resman. Besides executing

Resman to configure your instruments, you can use MAX to start resource

manager operations, or use MAX to configure Resman to run automatically

at startup.

NI Spy tracks the calls your application makes to National Instruments

T&M drivers, including NI-VXI, NI-VISA, and NI-488.2. NI Spy helps

you debug your application by clearly highlighting the functions that return

errors. You can let NI Spy keep a log of your program’s calls to these

drivers so that you can check for errors at your convenience.

National Instruments Application Software
In addition to the NI-VXI software, you can use the National Instruments

LabVIEW and Measurement Studio application programs and instrument

drivers to ease your programming tasks. These standardized programs

match the modular virtual instrument capability of VXI and can reduce

your VXI/VME software development time. These programs are fully

VXIplug&play compliant and feature extensive libraries of VXI
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instrument drivers written to take full advantage of direct VXI control.

LabVIEW and Measurement Studio include all the tools needed for

instrument control, data acquisition, analysis, and presentation.

LabVIEW is an easy-to-use, graphical programming environment you can

use to acquire data from thousands of different instruments, including

IEEE 488.2 devices, VXI devices, serial devices, PLCs, and plug-in data

acquisition boards. After you have acquired raw data, you can convert it

into meaningful results using the powerful data analysis routines in

LabVIEW. LabVIEW also comes with hundreds of instrument drivers,

which dramatically reduce software development time, because you do not

have to spend time programming the low-level control of each instrument.

Measurement Studio bundles LabWindows/CVI for C programmers,

ComponentWorks for Microsoft Visual Basic programmers, and

ComponentWorks++ for Microsoft Visual C++ programmers.

Measurement Studio is designed for building measurement and automation

applications with the programming environment of your choice:

• LabWindows/CVI is an interactive ANSI C programming

environment designed for building virtual instrument applications.

LabWindows/CVI delivers a drag-and-drop editor for building user

interfaces, a complete ANSI C environment for building your test

program logic, and a collection of automated code generation tools,

as well as utilities for building automated test systems, monitoring

applications, or creating laboratory experiments.

• ComponentWorks for Visual Basic is a collection of ActiveX controls

designed for building virtual instrumentation systems. Based on

ActiveX technology, ComponentWorks controls are configured

through simple property pages. You can use the ComponentWorks

VISA I/O controls and property pages to set up communication with

your instruments.

• ComponentWorks++ for Visual C++ takes advantage of integrated

C++ libraries and ActiveX to help you build measurement and

automation applications. With the ComponentWorks++ instrument

classes, you can use VISA to communicate with GPIB, VXI, or Serial

devices using the same set of components.

If you want to use either of these application programs, install them

after the NI-VXI software installation. Both LabVIEW and Measurement

Studio integrate well with PCI-based MXI-2 products. You also get

hundreds of complete instrument drivers, which are modular, source-code

programs that handle the communication with your instrument to speed

your application development.
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2
Setup

This chapter contains the instructions to set up your VXI/VME system

using the MXI-2 hardware and NI-VXI software.

Configuring the Hardware

This section contains basic information about configuring your MXI-2

hardware.

Note Install the NI-VXI software for Windows before installing the VXI hardware.

The default settings for your MXI-2 hardware are acceptable for most

applications. Refer to Appendix A, Default Settings, for a complete listing

of the hardware and software default settings.

The MXI-2 Configuration Reference Manual fully describes the

configuration and installation of each MXI-2 board discussed in this getting

started manual. Refer to the MXI-2 Configuration Reference Manual if you

want to try a different hardware configuration or would like more

information on a particular setting.

Use MAX to change PCI-MXI-2 or PXI-8320 configuration settings. For

information on the software, including optional settings, use MAX and its

online help. Access MAX from the Measurement & Automation icon on

the desktop. To access the MAX online help, choose Help»Help Topics.

Installing the Hardware

This section summarizes how to install your MXI-2 hardware.

Installing Your PCI-Based MXI-2 Interface
You received either a PCI-MXI-2 or a PXI-8320 in your kit.

Caution To guard against electrostatic discharge, touch the antistatic plastic package to a

metal part of your computer or chassis before removing the board from the package. Your

computer or chassis should be plugged in but powered off.
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Install the PCI-MXI-2 or PXI-8320 in an available peripheral slot in your

PCI-based computer or PXI/CompactPCI chassis. For more information,

refer to the PCI-MXI-2 or PXI-8320 chapter in the MXI-2 Configuration

Reference Manual.

Installing Your Mainframe Extender
You also received either a VXI-MXI-2, VXI-MXI-2/B, or VME-MXI-2 in

your kit.

Caution To guard against electrostatic discharge, touch the antistatic plastic package to a

metal part of your chassis before removing the module from the package. Your VXI or

VME chassis should be plugged in but powered off.

Install the VXI-MXI-2 or VXI-MXI-2/B in the first slot of a VXI chassis,

or install the VME-MXI-2 in the first slot of a VME chassis.

The VXI/VME-MXI-2 default configuration automatically detects whether

it should be the VXI/VMEbus system controller. The VXI/VMEbus system

controllers operate certain VXI/VMEbus lines as required for VXI/VME

systems. Verify that any other VXI/VME devices with system controller

capability that are in the same chassis are not configured as system

controller.

Caution Having more than one device configured as system controller can damage the

VXI/VME system.

For VXI systems that include VME devices, ensure that the VME devices

are not configured in the upper 16 KB (starting from 0xC000) of the

A16 address space. This region is reserved for VXI device configuration

registers, which are used for initializing, configuring, and interacting with

VXI devices. The PCI-MXI-2, PXI-8320, and VME-MXI-2 all use this

region for this purpose.

Also ensure that no VXI devices in your system are configured for either

logical addresses 0 or 1. These are the default configurations for the

PCI-MXI-2 or PXI-8320 and the VXI-MXI-2, respectively.

For more information, refer to the VXI-MXI-2, VXI-MXI-2/B, or

VME-MXI-2 chapter in the MXI-2 Configuration Reference Manual.



Chapter 2 Setup

© National Instruments Corporation 2-3 PCI-Based MXI-2 Interfaces for Windows 2000/NT/Me/98

Connecting the MXI-2 Cable Properly
By default, the PCI-MXI-2 or PXI-8320 automatically detects whether it

should be the system controller on the MXIbus. Verify that the correct

cable end labeled Connect This End To Device Closest To MXIbus

Controller In This Daisy Chain is attached securely to the PCI-MXI-2 or

PXI-8320. The cable must be connected in this manner so that the MXI

board can correctly detect whether it should be the system controller on the

MXIbus. Attach the other end of the cable to the VXI/VME-MXI-2.

Installing the Software for Windows 2000/NT/Me/98

Use the Setup program that came with your NI-VXI software to install the

entire software package or a software update, or to reinstall software in the

event that your files were accidentally erased. The Setup program works in

essentially the same way for Windows 2000/NT/Me/98.

Some of the utilities rely on the LabWindows/CVI Run-Time Engine.

This software is installed, if necessary, during the NI-VXI installation.

Depending on the type of installation you choose, you may need up

to 40 MB of free space available to accommodate the NI-VXI software.

If you choose the Custom installation method, Setup displays the amount

of space required for the options you select.

Installing the Software
This section describes how to install the NI-VXI software. Please carefully

read these directions along with any messages on the screen before making

your selections.

You can quit the Setup program at any time by pressing the Cancel button.

Setup is an interactive, self-guiding program that installs the NI-VXI

software and configures your system to use the software with the

PCI-MXI-2 or PXI-8320. Follow these steps to perform the installation:

1. Insert the CD-ROM labeled NI-VXI/NI-VISA for Windows.

2. Windows should automatically bring up an interactive menu. If it does

not, select Run... from the start menu and enter the following text,

where X is your CD-ROM:

X:\autorun.exe

and press <Enter>.
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3. Click on Install NI-VXI Software for Windows.

4. Click on the Next button at the Welcome screen to start the

installation.

Note If Setup detects a 2.x version of the NI-VXI software, it prompts you to remove it.

Setup will quit so you can uninstall the old software. If you have a previous 3.x version of

the NI-VXI software installed, Setup installs the new version over the previous version.

Caution If you want to keep the manufacturer/model name tables from a 2.x installation,

be sure to back them up before starting Setup.

5. Select the type of installation from the Choose Setup screen.

• Typical setup is the fastest and simplest installation option.

This option installs all the NI-VXI software in default directories

without prompting you to make any further choices.

• Custom setup gives you complete control over which files and

utilities you want installed on your system. This option is

recommended for advanced users.

6. The Typical setup completes without further questions. Follow

the prompts if you select the Custom setup options. The final prompt

asks for confirmation before beginning installation. Click on the Next

button to begin the installation.

7. Setup now copies the necessary files to your hard drive and creates

program icons.

Note If you need to change the set of NI-VXI files and utilities you have installed, you can

add or remove components after installation using Add/Remove Programs in the

Windows control panel.

Completing the Software Installation

1. Review the information in any README files that Setup prompts you

to read.

2. When the installation process completes, you must reboot your

computer for the changes to take effect. The NI-VXI driver is loaded

at this time.

3. If you backed up the manufacturer and model name files, restore

them to the TBL subdirectory of your NI-VXI directory before

running MAX.
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4. After you install the NI-VXI software, run MAX. In MAX, right-click

on your VXI system and choose Run VXI Resource Manager. You

must run Resman every time the chassis power is cycled so that your

application can access devices in the VXI/VME chassis. You can also

use MAX to configure Resman to run automatically at every computer

startup.

5. After you run Resman, you are ready to use MAX to interactively

configure the National Instruments hardware in your system. Use the

right-click help for information about the various configuration

options.

Verifying Your System Configuration

After you finish configuring the system through MAX, verify the system

configuration through one of the interactive control utilities such as

VISAIC. (Select Tools»NI-VISA»VISA Interactive Control.)

For more details about the utilities in NI-VXI, refer to Chapter 3,

Developing Your Application.
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3
Developing Your Application

This chapter discusses the software utilities you can use to start developing

applications that use NI-VXI.

After installing the NI-VXI software, you can begin developing your

VXI/VME application. Be sure to check the release notes for the latest

application development notes and changes.

NI-VXI, NI-VISA, and Related Terms

Before you develop your application, it is important to understand the

difference between NI-VXI, NI-VISA, and similar terms:

• NI-VXI is the software package that ships with National Instruments

VXI and VME controllers. NI-VXI includes Measurement &

Automation Explorer (MAX), NI-VISA, NI Spy, Resource Manager

(Resman), VXI device drivers, and other utilities for configuring and

controlling your VXI or VME system.

• NI-VISA is the native API for communicating with VXI/VME devices.

NI-VISA is the National Instruments implementation of the VISA I/O

standard, which is a common interface to many types of instruments

(such as VXI, GPIB, PXI, Serial, TCP/IP, etc.). NI-VXI is optimized

for use through NI-VISA, and we recommend using NI-VISA to

develop all new VXI/VME applications.

• The NI-VXI API is an optional development environment that is

not part of the default NI-VXI installation. The NI-VXI API was

developed before NI-VISA; while NI-VXI still supports the NI-VXI

API, we recommend using NI-VISA for all new VXI/VME

applications. If you must develop an application using the older

NI-VXI API, run the NI-VXI installer and select the appropriate option

in the custom installation screen. Be sure to review the NI-VXI API

Notes section later in this chapter.

• The NI-VXI compatibility layer allows older programs that use the

NI-VXI API to communicate with VXI devices through VISA. Using

this compatibility layer, older programs can run in NI-VXI 3.0 or later

without being rewritten to use the VISA interface. This layer installs

with NI-VXI by default. It should be completely transparent and
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provide a high level of performance; however, there may be some

slight changes in behavior for certain applications.

Your software features several system development utilities including

MAX, Resman, NI Spy, VISA Interactive Control (VISAIC), and VXI

Interactive Control (VIC, optional). You can also access online help and a

variety of examples to learn how to use NI-VXI for certain tasks.

Each component assists you with one of four development steps:

configuration, device interaction, programming, and debugging.

You can access the utilities, help files, and release notes through the

Windows Start menu by opening the National Instruments»VXI or

National Instruments»VISA program groups.

Configuration

The configuration utilities in your software kit are Resman and MAX.

Resman performs VXI Resource Manager functions as described in the

VXIbus specification. Resman configures all devices on the VXI backplane

for operation and allocates memory for devices that request it. Resman does

not require you to specify any settings; it automatically performs the VXI

resource management whenever you run it.

Note Power cycling resets all devices, so you must run Resman to reconfigure your

system every time you cycle the power on the chassis.

MAX presents a graphical display of your entire test and measurement

system to help you configure various components. When you launch MAX,

you see all your devices (including VXI and VME) on the screen. You can

view the properties (such as logical address, address space, and so on) of

each device by clicking on the device in the configuration tree. To see

additional configuration options for a given device, right-click on the

device in the configuration tree. When you access the properties of most

National Instruments devices by right-clicking, you can configure the

hardware settings by selecting Hardware Configuration.

MAX and Resman are designed to work together. You can run Resman

through MAX by either clicking on the Run VXI Resource Manager

button in the toolbar or right-clicking on a specific VXI system on which

to run Resman (see Figure 3-1). You can also select Tools»NI-VXI»

VXI Resource Manager to run Resman on all VXI systems. From the

VXI Options dialog in the Tools»NI-VXI menu, you can use MAX to
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configure Resman to run on all VXI systems automatically when the

computer boots. Resman reports to MAX all errors it finds in your system;

when you view your VXI system in MAX, you can easily spot any errors

that Resman found while configuring the system.

Figure 3-1. Right-Click on a VXI System in MAX to Run Resman on that System

After Resman detects and configures all your VXI/VME devices, you can

use MAX to view specific information about each device in your system.

The default MAX view of a VXI system shows the General tab window,

which contains a summary of key information about each device, including

its device name, logical address, model name, and other data.

For more information about MAX, refer to its online help by selecting the

Help»Help Topics menu.
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Device Interaction

You can interact with your VXI/VME devices using the VISA Interactive

Control (VISAIC) utility. VISAIC allows you to control your VXI/VME

devices without using a conventional programming language, LabVIEW,

or Measurement Studio. You can also control your devices in MAX by

right-clicking on a device name and selecting Open VISA Session.

Note You can also use VXI Interactive Control Program (VIC) to control your VXI/VME

devices and develop and debug VXI application programs. VIC is not included in the

default NI-VXI installation; to install it, select NI-VXI API Development from the

custom installation screen in the installer.

You can launch VISAIC (or VIC) from the Tools menu in MAX or from

the VISA or VXI subgroups in Start»Programs»National Instruments.

Try the following in VISAIC: In the tree view, navigate using your mouse

to the VISA resource for your controller—probably VXI0::0::INSTR,

representing the VXI system 0, logical address 0 instrument resource

(see Figure 3-2).

Figure 3-2. Select Your Controller in VISAIC
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Open the selected resource and navigate to the Register I/O tab. In this tab,

you can read registers on your device, such as the VXI device configuration

registers. Execute the viIn operation (called In in LabVIEW compatibility

mode) with the default parameters. The Data Value field shows the I/O

operation result, such as 0x9ff6. The Return Value field shows the

function status, such as 0 for VI_SUCCESS (see Figure 3-3).

Figure 3-3. Successful viIn Access in the VISAIC Register I/O Tab
(This Dialog Box May Look Slightly Different for LabVIEW Users)

If the data value ends in ff6, you have successfully read the National

Instruments manufacturer ID from your VXI/VME controller’s ID register.

You may now want to read the configuration registers from other VXI

devices in your system by opening the devices in VISAIC. Try reading a

register from each device listed in the MAX view of your VXI system. This

way, you can verify that your VXI controller can access each device in your

VXI system successfully.
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You can also access VXI and VME devices configured in A16, A24, or

A32 space by opening the VXI MEMACC resource, VISA’s representation

of VXI memory. For more information about VISAIC operations and

commands, refer to the online help in the Help menu and the

context-sensitive help (such as What’s This?) available by right-clicking

in any panel.

Programming for VXI

NI-VISA and the NI-VXI API are the two National Instruments

programming interfaces for accessing your VXI/VME instruments. With

NI-VXI 3.0 or later, NI-VISA is the native API for communicating with a

VXI or VME system, and we recommend using it for all new applications.

Older programs that use the NI-VXI API now use the NI-VXI-to-NI-VISA

compatibility layer to communicate with the VXI devices. Using this layer,

older programs can run in NI-VXI 3.0 or later without being rewritten to

use the VISA interface.

Note The NI-VXI API development environment is not installed by default as part of the

NI-VXI installation. If you must develop an application using the older NI-VXI API, run

the NI-VXI installer and select the appropriate option in the custom installation screen.

Be sure to review the NI-VXI API Notes section later in this chapter.

NI-VISA is the National Instruments implementation of the VISA API as

the VXIplug&play standard defines. It provides a common interface to

many types of instruments (such as VXI, GPIB, PXI, Serial, TCP/IP, etc.)

and therefore is especially useful in situations where you are using multiple

types of instruments.

Both NI-VISA and the NI-VXI API include functions for register-level

access to VXI instruments and messaging capability to message-based

devices. You can also use either interface to service asynchronous events

such as triggers, signals, and interrupts, and also assert them. Compatibility

with the NI-VXI API is included for legacy applications only—we

recommend that you write all new VXI/VME applications in VISA.

The best way to learn NI-VISA programming is by reviewing the example

programs your software includes. The examples directory contains working

VISA programs that illustrate many different types of applications. You can

find these examples in the VXIpnp\WinXX\NIvisa\Examples directory.

If you are just getting started, you should learn how to access registers

with high-level calls and send messages with word-serial functions.
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The NI-VISA examples for these tasks are HighReg.c and RdWrt.c.

Refer to the other examples as you try more advanced techniques. Consult

the NI-VISA User Manual or online help for additional information on

these topics.

Table 3-1 summarizes the topics the example programs address. (All VISA

files are in the VXIpnp\WinXX\NIvisa\Examples directory, in the

subdirectories listed below.)

Note MAX includes configuration options that affect low-level functions and shared

memory, as well as trigger mappings and other attributes of your VXI system. Refer to the

MAX online help for information regarding these options.

Optimizing Large VXIbus Transfers
For best performance, keep the following in mind when using viMove()

or VXImove():

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Use VXI block access privileges to significantly improve performance

to devices that are capable of accepting block transfers.

Table 3-1. NI-VISA/NI-VXI Examples

Coverage NI-VISAExample

NI-VXIExample

(Optional)

Message-Based

Access

General\RdWrt.c VXIws.c

High-Level

Register Access

VXI-VME\HighReg.c VXIhigh.c

Low-Level

Register Access

VXI-VME\LowReg.c VXIlow.c

Sharing Memory VXI-VME\ShareSys.c VXImem.c

Interrupt Handling VXI-VME\AsyncIntr.

c and WaitIntr.c

VXIint.c

Trigger Handling VXI-VME\WaitTrig.c VXItrig.c
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• To optimize move performance on virtual memory systems, lock the

user buffer in memory yourself so the move operation does not need to

lock the buffer.

• To optimize move performance on paged memory systems, use a

contiguous buffer so the move operation does not need to build a

scatter-gather list for the user buffer.

Note viMemAlloc() or VXImemAlloc() returns 32-bit aligned, page-locked,

continuous buffers which work efficiently with the move operations.

Shared Memory
In the Hardware Configuration settings for your controller in MAX,

you can share memory on your computer or from DRAM added to the

PCI-MXI-2 or VXI-MXI-2 if you have any installed. Right-click on any

setting or consult the MAX online help for more information. You can

access shared memory on your computer using viMemAlloc() in VISA

(or VXImemAlloc() in the NI-VXI API).

Note that the viMemAlloc() function allocates RAM from the

workstation’s system RAM, not from the onboard RAM on the controller.

To access onboard RAM on the controller, use it as if it is VXI

memory—that is, by using high-level or low-level VXIbus access

functions. Use MAX to view the VXI address space and base address of the

controller’s RAM, or determine this information programmatically using

VISA’s viGetAttribute().

NI-VXI API Notes
The following notes apply only if you are using the NI-VXI API. We

recommend that all new VXI/VME applications use the NI-VISA API,

but you can still develop with the older NI-VXI API for compatibility

with legacy code.

Compiler Symbols
You may need to define certain compiler symbols so that the NI-VXI

library can work properly with your program. The required symbol

indicates your operating system platform; for example, VXINT designates

the application as a Windows 2000/NT/Me/98 application.

Note LabWindows/CVI automatically defines the correct symbol. You do not need to

define VXINT when using LabWindows/CVI.
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You can define this symbol using #define statements in your source code

or using the appropriate option in your compiler (typically either -D or /D).

If you use #define statements, they must appear in your code before the

line that includes the NI-VXI API header nivxi.h.

Compatibility Layer Options
Although NI-VXI supports multiple VXI controllers through NI-VISA, the

NI-VXI API supports only a single controller. To specify which controller

the emulation layer should use, run MAX. Select Tools»NI-VXI»VXI

Options. Select the VXI system that will support the emulation layer.

In NI-VXI 3.0 or later, when you enable for triggers or interrupts, only the

local controller is enabled. In the NI-VXI API functions for enabling

triggers and interrupts, the controller parameter is ignored. If you need to

enable a remote controller for triggers, use the MAX frame resource to map

the trigger back to the local controller.

The interrupt and trigger routing in the NI-VXI 3.0 or later low-level

drivers is somewhat different from the default routing in previous versions

of NI-VXI. Therefore, the compatibility layer may behave differently than

the original NI-VXI API with regard to these settings. In particular, if you

are receiving triggers on an external controller, you may need to modify the

trigger configuration on your extender module using MAX. In general,

interrupts are routed automatically based on the interrupt configuration the

resource manager detects. Whether the changed routing behavior affects

your program is application dependent.

Because VISA is an instrument-centric API, certain functions from the

more controller-centric NI-VXI API do not match perfectly with a VISA

counterpart. When an application enables an event with the NI-VXI

API compatibility layer, each logical address is enabled for that event

separately. For example, if the application enables an interrupt level,

VISA will enable the interrupt on each logical address, one at a time,

until all the devices are enabled. This means that some interrupts could be

lost from devices with higher numbered logical addresses. MAX provides

an option for users to pick which logical address is enabled first. Select

Tools»NI-VXI»VXI Options. Set Prioritized Signal LA to the logical

address of the device that generates the events. This prevents possible loss

of events from that device.
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Debugging

NI Spy and VISAIC are useful utilities for identifying the causes of

problems in your application.

NI Spy tracks the calls your application makes to National Instruments

programming interfaces, including NI-VISA, NI-VXI, and NI-488. NI Spy

highlights functions that return errors, so during development you can

quickly spot which functions failed during a program’s execution. NI Spy

can log the calls your program makes to these drivers so you can check

them for errors at your convenience, or use the NI Spy log as a reference

when discussing the problem with National Instruments technical support.

Figure 3-4 shows an example of a normal error returned from a call to

viMemAlloc when no memory has been shared.

Figure 3-4. NI-Spy
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VISAIC, discussed above in the Device Interaction section of this chapter,

is an excellent platform for quickly testing instruments and learning how to

communicate with them.

Figure 3-5. VISAIC
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A
Default Settings

This section summarizes the hardware and software default settings for the

hardware and software in your kit. If you need more information about a

particular setting, or if you want to try a different configuration, please refer

to the appropriate hardware or software chapters in this documentation set.

Use the MXI-2 Configuration Reference Manual for your hardware

reference and the MAX online help for your software reference.

PCI-MXI-2/PXI-8320

This section summarizes the hardware and software default settings for the

PCI-MXI-2 and PXI-8320.

Hardware Settings

Table A-1. PCI-MXI-2 Hardware Default Settings

Hardware Component Default Setting

U17 Switch 1 (FOV) OFF: PCI-MXI-2 boots off the

user-configured half of the EEPROM

U17 Switch 2 (TST) OFF: Factory configuration of the

EEPROM is protected

U17 Switch 3 (POS) OFF: Do not alter this setting

U17 Switch 4 (CT) ON: Do not alter this setting

DRAM SIMM installed Per customer order
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MAX Settings

Table A-2. PXI-8320 Hardware Default Settings

Hardware Component Default Setting

U6 Switch 1 (FOV) OFF: PXI-8320 boots off the

user-configured half of the EEPROM

U6 Switch 2 (TST) OFF: Factory configuration of the

EEPROM is protected

U6 Switch 3 (POS) OFF: Do not alter this setting

U6 Switch 4 (CT) ON: Do not alter this setting

DRAM SODIMM installed Per customer order

Table A-3. Device Tab Default Settings

Editor Field Default Setting

Logical address 0

Device class Message-based

Size of Servant area 0

Number of handlers 1

Number of interrupters 0
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Table A-4. Shared Memory Tab Default Settings

Editor Field Default Setting

Memory sharing Don’t share memory

Shared RAM size 0 KB

Reserved physical memory 0 KB

Lower half window byte swapping Disabled

Lower half window memory selection System memory

Upper half window byte swapping Disabled

Upper half window memory selection System memory

Map upper and lower halves at same

PCI address

Disabled

Table A-5. MXI-2 Bus Tab Default Settings

Editor Field Default Setting

Bus timeout 1 ms

System controller Auto-detect

MXI-2 auto retry Enabled

A24/A32 write posting Disabled

VXImove uses Synchronous MXI Enabled

MXI transfer limit Unlimited

MXI CLK10 signal Receive
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VXI/VME-MXI-2

This section summarizes the hardware and software default settings for the

VXI-MXI-2, VXI-MXI-2/B, and VME-MXI-2.

Hardware Settings

Table A-6. PCI Tab Default Settings

Editor Field Default Setting

Low-level register access API support Enabled

User window size 64 KB

Expansion ROM Enabled

Table A-7. VXI-MXI-2 Hardware Default Settings

Hardware Component Default Setting

Logical address (U43) 1

VXIbus Slot 0/Non-Slot 0 (W2) Automatic detection

VXIbus local bus (S8, S9) Both OFF: single

VXI-MXI-2

VXIbus CLK10 routing (W3) From onboard oscillator

External trigger termination (S2) OFF: unterminated

SMB CLK10 direction (S3) OUT: drive CLK10 signal

SMB CLK10 termination (S4) Ignored; effective only when

S3 is set to IN

Polarity of external SMB CLK10 (S5) Inverted

MXIbus CLK10 signal (S7) Receive CLK10 from

MXIbus
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MXIbus termination

(U35 switches 1 and 2)

Automatic MXIbus

termination: switch 2 set to

NO; switch 1 ignored

Configuration EEPROM

(U35 switches 3 and 4)

User-modifiable; factory

settings protected: both

switches set to NO

DRAM SIMMs installed Per customer order

SIMM size configuration (S6) OFF if SIMMS are 4 M × 32

or larger; ON if smaller than

4 M × 32

Table A-8. VXI-MXI-2/B Hardware Default Settings

Hardware Component Default Setting

Logical address (U20) 1

VXIbus Slot 0/Non-Slot 0 (W3) Automatic detection

VXIbus local bus (W2) Single VXI-MXI-2/B in frame

VXIbus CLK10 routing (W1) From onboard oscillator

External trigger termination (S5) OFF: unterminated

SMB CLK10 direction (S7) OUT: drive CLK10 signal

SMB CLK10 termination (S6) Ignored; effective only when

S7 is set to IN

Polarity of external SMB CLK10

(S3)

Inverted

MXIbus CLK10 signal (S1) Receive CLK10 from MXIbus

Table A-7. VXI-MXI-2 Hardware Default Settings (Continued)

Hardware Component Default Setting
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MXIbus termination

(U21 switches 3 and 4)

Automatic MXIbus

termination: switch 3 set to

OFF; switch 4 ignored

Configuration EEPROM

(U21 switches 1 and 2)

User-modifiable; factory

settings protected: both

switches set to OFF

Table A-9. VME-MXI-2 Hardware Default Settings

Hardware Component Default Setting

A16 base address (U20) Hex C040

VME-MXI-2 intermodule signaling

(W2)

No user-defined pin selected

MXIbus termination

(U21 switches 3 and 4)

Automatic MXIbus

termination: switch 3 OFF;

switch 4 ignored

Configuration EEPROM

(U21 switches 1 and 2)

User-modifiable; factory

settings protected: both

switches OFF

DRAM SIMMs installed Per customer order

SIMM size configuration (S2) OFF if SIMMS are 4 M × 32

or larger; ON if smaller than

4 M × 32

Table A-8. VXI-MXI-2/B Hardware Default Settings (Continued)

Hardware Component Default Setting
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MAX Settings

Table A-10. Device Tab Default Settings

Editor Field Default Setting

Logical address Use DIP switch

Address space A24 *

Requested memory 16 KB *

A24/A32 write posting Disabled

A16 write posting Disabled

Interlocked mode Disabled

* Assumes no DRAM is installed. If DRAM is installed, the Address space should be

A32, and Requested memory should match the amount of DRAM. If you install the

DRAM yourself, you must manually specify these changes.

Table A-11. VXI/VME Bus Tab Default Settings

Editor Field Default Setting

Bus timeout value 125 µs

Slot 0 configuration Auto-detect

Auto retry Disabled

Transfer limit 256

Arbiter type Priority

Fair requester Enabled

Arbiter timeout Enabled

Request level 3
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Table A-12. MXI-2 Bus Tab Default Settings

Editor Field Default Setting

System controller Auto-detect

Bus timeout value 1 ms

MXI-2 auto retry Disabled

MXI transfer limit Unlimited

MXI fair requester Disabled

Perform parity checking Enabled

MXI-2 CLK10 signal direction Switch determines signal

direction (VXI-MXI-2 only)
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B
Common Questions

This appendix addresses common questions you may have about using the

NI-VXI/NI-VISA software on the PCI-MXI-2 or PXI-8320 platform.

What are some of the differences between the old utilities and the

current ones?

The old utility components are as follows:

• VXIinit—This utility initializes your National Instruments controller

hardware with settings determined in VXIedit.

• Resman—This utility initializes and configures all the other devices in

your VXI system.

• VXIedit—This utility configures your National Instruments hardware.

• VXItedit—This is a console-based version of VXIedit.

• VIC—Use this utility to interactively communicate with VXI devices

over the VXIbus using the NI-VXI API.

• VICtext—This is a console-based version of VIC.

• VISAconf—This utility configures settings used by NI-VISA

• T&M Explorer—Use this utility to configure, view, and initialize your

system.

VXI system integration with the old utilities typically proceeded as

follows:

1. Install components and boot the system.

2. Configure your hardware with VXIedit.

3. Reboot and run VXIinit to initialize your National Instruments

Hardware.

4. Run Resman to initialize the VXIbus.

5. Optionally run VXIedit to configure any extender devices on the

VXIbus.

6. Run VIC to verify device operation.

7. Run VISAIC to verify that you can communicate with your system

using VISA.
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The current utility components are as follows:

• MAX—Use this utility to configure, view, and initialize your system.

• Resman—You can still use this as before. However, you can perform

resource manager operations directly from MAX or configure it to run

Resman automatically at startup. See What about running Resman?

later in this appendix.

• VISAIC—Use this utility to interactively communicate with VISA

devices (GPIB, VXI, Serial) using NI-VISA.

• NI Spy—Use this utility to debug your NI-VXI or NI-VISA

application.

Your setup may now include the following steps:

1. Install components and boot the system.

2. Launch MAX. Optionally, change your hardware configuration and

reboot if necessary.

3. Execute VXI Resource Manager. (Run Resman by clicking the

Run VXI Resource Manager button in the MAX toolbar.)

4. Run VISAIC to verify that you can communicate with your VXI

system.

What happened to VXIinit?

You no longer need to run VXIinit to initialize settings on your hardware.

We now take care of loading hardware settings in the driver, completely

eliminating the need for VXIinit. Therefore, VXIinit no longer exists.

Where do I find the information that VXIinit used to print?

You can view information about your controller from the properties pages

and the hardware configuration pages. For example, you can view logical

address and user window size in the configuration view in MAX.

What happened to T&M Explorer?

The functionality of this utility has been integrated into a powerful utility

called MAX. This utility starts with a graphical view of the VISA devices

(GPIB, VXI, and Serial) that it finds in your system. Right-click on an

individual device in the configuration tree to see its properties. You can

further configure National Instruments devices by selecting the Hardware

Configuration option. This includes National Instruments DAQ products,

which means you can configure these devices from MAX without running

the DAQ Configuration Utility.
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What about running Resman?

Resman is the name of the utility that performs the duties of a VXI

Resource Manager as discussed in the VXIbus specification. When

you set a National Instruments controller to Logical Address 0, you will

at some point need to run Resman to configure your VXI instruments.

If your controller uses a different (non-zero) logical address and is a

message-based device, you need to start Resman on your non-Logical

Address 0 controller before running it on the Logical Address 0 computer.

So when do you need to run Resman?

Run Resman whenever you need to configure your VXI instruments.

For example, if you power-cycle your VXI chassis, your instruments will

be reset, and you will need to run Resman to configure them. You can get

into trouble if you run Resman when your devices are not in a reset state.

Therefore, if you need to run Resman after running it once, you should reset

all of your VXI instruments.

You can perform resource manager operations from within MAX.

Additionally, you can use MAX to configure Resman to run when the

computer first boots. In this case you may never need to run Resman

explicitly again. This is common when you use an embedded VXI

controller such as a VXIpc. You can configure the computer to run Resman

at startup, so when you power the chassis, Resman runs. Power cycling the

chassis reboots the embedded PC, causing Resman to run again.

With the PCI-MXI-2 or PXI-8320, you may need to run the Resman utility

if you boot your computer before turning on your VXI chassis or if you

power-cycle your VXI chassis while the external PC remains on. In these

cases, the instruments would have been reset without the computer

rebooting. You will need to run the Resman utility or configure your system

in MAX to initialize your VXI system.

What if I have a system that requires the old utilities?

The NI-VXI installer gives you the option of installing some of the old

utilities. Thus, if you have a documented procedure for configuring your

system that relies on the old configuration utilities, you can install them on

your system. Use the Custom installer option to add the old utilities.

However, certain very old utilities are now obsolete and are no longer part

of NI-VXI.

You can optionally install VIC for users familiar with this interactive VXI

utility. Also, the MAX configuration panels are in many cases identical to

the panels in T&M Explorer.
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Why do you include some of the old utilities?

Utilities such as VIC still have a lot of functionality that our current utilities

do not include. Therefore, it makes sense to distribute these utilities as part

of a normal distribution.

How do I handle VME devices?

Although there is no way to automatically detect VME devices in a system,

you can add them easily through the Create Device Wizard in MAX.

Through this procedure, you can reserve resources for each of your VME

devices and see them on the screen with all your other devices in MAX.

How can I determine which version of the NI-VXI software I have

installed?

There are several ways to find this information.

• In MAX, expand Software and click on each component you have

installed to get more information about that component.

• You can find version information about the VISA driver through

VISAIC by selecting About... from the Help menu.

• Under Windows 2000/NT/Me/98, you can find version information by

right-clicking on any component and selecting the Properties option.

This displays a property sheet with a version tab. This tab has version

information about the product (NI-VXI) and the component

(NIVXINT.DLL, for example).

• You can find version information about the NI-VXI API by running the

VIC utility program. Type ver at the prompt, and the utility displays

the versions of VIC and NI-VXI, and the latest PCI-MXI-2

or PXI-8320 board revision that this NI-VXI driver supports.

How can I determine the serial number and hardware revision of the

MXI-2 boards?

Run MAX and right-click on the name of the MXI-2 board in the

configuration tree. Select Hardware Configuration, and the dialog box

for the MXI-2 board is displayed. The title bar includes the serial number

and hardware revision of the board.

Which NI-VXI utility programmust I use to configure the PCI-MXI-2

or PXI-8320?

Use MAX to configure the PCI-MXI-2 or PXI-8320. Access MAX from its

desktop icon.
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Which NI-VXI utility program must I use to initialize the PCI-MXI-2

or PXI-8320?

Windows 2000/NT/Me/98 automatically initializes the board at system

startup.

WhichNI-VXI utility programmust I use to perform startupResource

Manager operations?

Use the Resman program to perform startup Resource Manager operations.

You can run Resman by selecting a VXI system and clicking on the Run

VXI Resource Manager button in the MAX toolbar. Resman uses the

settings configured in MAX and initializes your VXI/VMEbus system.

Through MAX, you can also configure Resman to run automatically at

computer startup.

What can I do to make sure my system is up and running?

The fastest method for testing the system is to run Resman. This program

attempts to access memory in the upper A16 address space of each device

in the system. If Resman does not report any problems, the VXI/MXI

communication system is operational.

To test individual devices, you can use VISAIC or VIC to interactively

issue NI-VISA operations or NI-VXI functions, respectively. You can use

the viIn/Out() or VXIin/out() functions or the VXIin/outReg()

functions to test register-based devices by programming their registers. If

you have any message-based devices, you can send and receive messages

with the viWrite/Read() or WSwrt/rd() functions. Notice that

VXIin/outReg() are for VXI devices only, but you can use viIn/Out()

or VXIin/out() for both VXI and VME.

Finally, if you are using LabVIEW or Measurement Studio and you

have instrument drivers for the devices in your chassis, you can use the

interactive features of these programs to quickly test the functionality of

the devices.
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What should I do if I get a Configuration EEPROM is Invalid

message?

There are several reasons why you might get theConfiguration EEPROM 

is Invalid message. If you turned off the computer while the

configuration update process was still in progress, the board functions

normally except when running MAX. To correct these problems, reboot the

computer with the Factory Override (FOV) switch set (as described in

Appendix B, EEPROM Configuration, in the MXI-2 Configuration

Reference Manual) and update the configuration, or load the configuration

from a file.

Two other reasons you might receive this error message are that the board

might have an incorrect base address assigned for the driver window, or

there may be a conflict with another adapter or memory management

software.

What should I do if Resman hangs?

1. Ensure that the MXI-2 cable is plugged in and that the end labeled

Connect this end to the device closest to the MXIbus System Controller

is connected to the MXIbus system controller (by default the

PCI-MXI-2 or PXI-8320). Because the MXI-2 cables are polarized,

it matters which end is connected to which device.

2. Check for bent or broken pins on the MXI-2 connectors.

3. If you are using a VME-MXI-2 in the first slot of a VMEbus chassis,

the chassis may be causing problems with the First Slot Detection

circuit on the VME-MXI-2. Use MAX to change the Slot 0

Configuration setting of the VME-MXI-2 to Slot 0 rather than

Auto-detect before running Resman again. You must then enter the

logical address of the VME-MXI-2 to configure.

4. If problems persist, run Resman with the VXI/VME-MXI-2 located in

the leftmost slot of your chassis (VXI Slot 0) and no other instruments

installed. If this works, try adding instruments until the problem occurs

again. Contact National Instruments for further assistance.

Where can I find hardware specifications?

Refer to Appendix A, Specifications, in the MXI-2 Configuration

Reference Manual.
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What do the LEDs on the front of the VXI-MXI-2 or VME-MXI-2

mean?

The SYSFAIL LED shows the state of the VXIbus/VMEbus SYSFAIL

line. This line is asserted whenever any device in the chassis has not yet

passed its self test, if it has failed its self test, or if it has detected a failure

after originally passing its self test. The MXI LED indicates that the

VXI-MXI-2 or VME-MXI-2 is acting as a slave to another device on the

MXIbus, such as when the PCI-MXI-2 or PXI-8320 communicates with

either the VXI-MXI-2 or VME-MXI-2 or with another device in the

chassis. The VXI (VME) LED, when lit, indicates that the VXI-MXI-2 or

VME-MXI-2 is acting as a slave to another device in the VXI (VME)

chassis, such as when a bus master inside the chassis wants to talk to either

the VXI-MXI-2 or VME-MXI-2 or another device outside the chassis.

Are the VXI-MXI-2 and either the PCI-MXI-2 or PXI-8320 two

devices or one with respect to the VXIbus?

The PCI-MXI-2, PXI-8320, and the VXI-MXI-2 are unique VXIbus

devices with their own logical addresses. However, the MXIbus allows the

PCI or PXI/CompactPCI computer to behave as if it is inside the chassis

with the VXI-MXI-2 by transparently converting PCI bus cycles to MXIbus

cycles to VXIbus cycles, and vice versa.

I have a system that requires rugged chassis and bulkhead cables.

Can I still use MXIbus?

Yes, National Instruments sells MXIbus bulkhead cables. Contact National

Instruments for further information.

What kind of signal is CLK10 and what kind of signal do I need for an

external CLK10?

CLK10 is a differential ECL signal on the VXIbus backplane. However, the

oscillator for the VXI-MXI-2 and the EXTCLK input from the front panel

use TTL. Therefore, supply a TTL-level signal for EXTCLK; our voltage

converters will convert the signal to differential ECL.

CLK10 is not applicable to VME.

What is the accuracy of the CLK10 signal?

The CLK10 generated by the VXI-MXI-2 is 100 ppm (0.01%) as per the

VXIbus specification. If you need a more accurate CLK10 signal, you can

use the EXTCLK input at the front of the VXI-MXI-2.

CLK10 is not applicable to VME.
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What are the user and driver windows?

The PCI-MXI-2 and PXI-8320 driver requires the use of two PCI windows:

a user window and a driver window. NI-VXI uses the driver window to

perform high-level functions such as viIn/Out() or VXIin/out() and

to access registers on the MXI-2 boards in the system. The user window

is reserved for low-level function calls, such as viPeek/Poke() or

VXIpeek/poke(), and viMapAddress or MapVXIAddress(). The

driver window is system defined and not configurable, but you can increase

the size of your user window through MAX if you expect to initiate

transfers to a wide variety of addresses in both A24 and A32 address space.

What is shared memory and dual-ported memory?

These terms refer to a block of memory that is accessible to both a client

and a server. The memory block operates as a message buffer for

communications. Shared memory is needed only if you have devices

capable of bus mastering in A24 or A32 space.

How should I assign logical addresses in a multiple-mainframe

system?

A simple algorithm for a system containing only one level of hierarchy—

a single chain of MXI cables—is to use the upper nibble (most significant

four bits) as a frame number and the lower nibble (least significant four

bits) as a device number. For example, the fifth device in the third

mainframe would be logical address 35 (hex).

For more detailed information on this topic, refer to the VXI-MXI-2 User

Manual, the VME-MXI-2 User Manual, or VXI-6, VXIbus Mainframe

Extender Specification. You can also download the Logical Address

Wizard, a useful tool for determining logical address assignments, from

ni.com.
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C
Technical Support Resources

Web Support

National Instruments Web support is your first stop for help in solving

installation, configuration, and application problems and questions. Online

problem-solving and diagnostic resources include frequently asked

questions, knowledge bases, product-specific troubleshooting wizards,

manuals, drivers, software updates, and more. Web support is available

through the Technical Support section of ni.com.

NI Developer Zone

The NI Developer Zone at ni.com/zone is the essential resource for

building measurement and automation systems. At the NI Developer Zone,

you can easily access the latest example programs, system configurators,

tutorials, technical news, as well as a community of developers ready to

share their own techniques.

Customer Education

National Instruments provides a number of alternatives to satisfy your

training needs, from self-paced tutorials, videos, and interactive CDs to

instructor-led hands-on courses at locations around the world. Visit the

Customer Education section of ni.com for online course schedules,

syllabi, training centers, and class registration.

System Integration

If you have time constraints, limited in-house technical resources, or other

dilemmas, you may prefer to employ consulting or system integration

services. You can rely on the expertise available through our worldwide

network of Alliance Program members. To find out more about our

Alliance system integration solutions, visit the System Integration section

of ni.com.
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Worldwide Support

National Instruments has offices located around the world to help address

your support needs. You can access our branch office Web sites from the

Worldwide Offices section of ni.com. Branch office Web sites provide

up-to-date contact information, support phone numbers, e-mail addresses,

and current events.

If you have searched the technical support resources on our Web site and

still cannot find the answers you need, contact your local office or National

Instruments corporate. Phone numbers for our worldwide offices are listed

at the front of this manual.
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Glossary

Prefix Meaning Value

p- pico- 10–12

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

k- kilo- 103

M- mega- 106

G- giga- 109

t- tera- 1012

A

A16 space VXIbus address space equivalent to the VME 64 KB short address space.

In VXI, the upper 16 KB of A16 space is allocated for use by VXI devices

configuration registers. This 16 KB region is referred to as VXI

configuration space.

A24 space VXIbus address space equivalent to the VME 16 MB standard address

space

A32 space VXIbus address space equivalent to the VME 4 GB extended address space

ACFAIL A VMEbus backplane signal that is asserted when a power failure has

occurred (either AC line source or power supply malfunction), or if it is

necessary to disable the power supply (such as for a high-temperature

condition)

address Character code that identifies a specific location (or series of locations) in

memory. In VISA, it identifies a resource.

address modifier One of six signals in the VMEbus specification used by VMEbus masters

to indicate the address space in which a data transfer is to take place
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address space A set of 2n memory locations differentiated from other such sets in

VXI/VMEbus systems by six addressing lines known as address modifiers.

n is the number of address lines required to uniquely specify a byte location

in a given space. Valid numbers for n are 16, 24, and 32. In VME/VXI,

because there are six address modifiers, there are 64 possible address

spaces.

address window A portion of address space that can be accessed from the application

program

ANSI American National Standards Institute

API Application Programming Interface; the direct interface that an end user

sees when creating an application

arbitration A process in which a potential bus master gains control over a particular bus

asynchronous Not synchronized; not controlled by time signals

B

B bytes

backplane An assembly, typically a printed circuit board, with 96-pin connectors and

signal paths that bus the connector pins. A C-size VXIbus system will have

two sets of bused connectors called J1 and J2. A D-size VXIbus system will

have three sets of bused connectors called J1, J2, and J3.

BERR* Bus error signal

block-mode transfer An uninterrupted transfer of data elements in which the master sources only

the first address at the beginning of the cycle. The slave is then responsible

for incrementing the address on subsequent transfers so that the next

element is transferred to or from the proper storage location. In VME,

the data transfer may have no more than 256 elements; MXI does not have

this restriction.

BTO unit Bus Timeout Unit; a functional module that times the duration of each data

transfer and terminates the cycle if the duration is excessive. Without the

termination capability of this module, a bus master attempt to access a

nonexistent slave could result in an indefinitely long wait for a slave

response.
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bus error An error that signals failed access to an address. Bus errors occur with

low-level accesses to memory and usually involve hardware with bus

mapping capabilities. For example, nonexistent memory, a nonexistent

register, or an incorrect device access can cause a bus error.

bus master A device that is capable of requesting the Data Transfer Bus (DTB) for the

purpose of accessing a slave device

byte order How bytes are arranged within a word or how words are arranged within a

longword. Motorola ordering stores the most significant (MSB) byte or

word first, followed by the least significant byte (LSB) or word. Intel

ordering stores the LSB or word first, followed by the MSB or word.

C

CLK10 A 10 MHz, ±100 ppm, individually buffered (to each module slot),

differential ECL system clock that is sourced from Slot 0 of a VXIbus

mainframe and distributed to Slots 1 through 12 on P2. It is distributed to

each slot as a single-source, single-destination signal with a matched delay

of under 8 ns.

Commander A message-based device that is also a bus master and can control one or

more Servants

CompactPCI An adaptation of the PCI specification for industrial and/or embedded

applications that require a more robust mechanical form factor than desktop

PCI. CompactPCI provides a standard form factor for those applications

requiring the high performance of PCI as well as the small size and

ruggedness of a rack-mount system.

configuration

registers

A set of registers through which the system can identify a module device

type, model, manufacturer, address space, and memory requirements.

To support automatic system and memory configuration, the VXIbus

specification requires that all VXIbus devices have a set of such registers.

D

daisy-chain A method of propagating signals along a bus, in which the devices are

prioritized on the basis of their position on the bus

Data Transfer Bus DTB; one of four buses on the VMEbus backplane. The DTB is used by a

bus master to transfer binary data between itself and a slave device.
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DMA Direct Memory Access; a method by which data is transferred between

devices and internal memory without intervention of the central processing

unit

DRAM Dynamic RAM (Random Access Memory); storage that the computer must

refresh at frequent intervals

driver window A region of PCI address space that is decoded by the PCI-MXI-2 or

PXI-8320 for use by the NI-VXI software

DTB See Data Transfer Bus.

dynamic configuration A method of automatically assigning logical addresses to VXIbus devices

at system startup or other configuration times

dynamically

configured device

A device that has its logical address assigned by the Resource Manager.

AVXI device initially responds at Logical Address 255 when its MODID

line is asserted. A MXIbus device responds at Logical Address 255 during

a priority select cycle. The Resource Manager subsequently assigns it a new

logical address, which the device responds to until powered down.

E

ECL Emitter-Coupled Logic

EEPROM Electronically Erasable Programmable Read Only Memory

embedded controller An intelligent CPU (controller) interface plugged directly into the VXI

backplane, giving it direct access to the VXIbus. It must have all of its

required VXI interface capabilities built in.

expansion ROM An onboard EEPROM that may contain device-specific initialization and

system boot functionality

external controller In this configuration, a plug-in interface board in a computer is connected

to the VXI mainframe via one or more VXIbus extended controllers. The

computer then exerts overall control over VXIbus system operations.

F

fair requester A MXIbus master that will not arbitrate for the MXIbus after releasing it

until it detects the bus request signal inactive. This ensures that all

requesting devices will be granted use of the bus.
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G

GPIB General Purpose Interface Bus (IEEE 488)

H

hex hexadecimal; the numbering system with base 16, using the digits 0 to 9

and letters A to F

Hz hertz; cycles per second

I

I/O input/output; the techniques, media, and devices used to achieve

communication between machines and users

IEEE Institute of Electrical and Electronics Engineers

instrument driver A set of routines designed to control a specific instrument or family of

instruments, and any necessary related files for LabWindows/CVI or

LabVIEW

interrupt A means for a device to request service from another device

interrupt handler A VMEbus functional module that detects interrupt requests generated by

Interrupters and responds to those requests by requesting status and identify

information

interrupt level The relative priority at which a device can interrupt

K

KB Kilobytes of memory

L

logical address An 8-bit number that uniquely identifies each VXIbus device in a system.

It defines the A16 register address of a device, and indicates Commander

and Servant relationships.
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M

m meters

master A functional part of a MXI/VME/VXIbus device that initiates data transfers

on the backplane. A transfer can be either a read or a write.

master-mode

operation

A device is in master mode if it is performing a bus cycle which it initiated.

MAX Measurement & Automation Explorer; an environment to view, configure,

and interact with hardware.

MB Megabytes of memory

MBLT Eight-byte block transfers in which both the Address bus and the Data bus

are used to transfer data

message-based

device

An intelligent device that implements the defined VXIbus registers and

communication protocols. These devices are able to use Word Serial

Protocol to communicate with one another through communication

registers.

MITE A National Instruments custom ASIC, a sophisticated dual-channel DMA

controller that incorporates the Synchronous MXI and VME64 protocols to

achieve high-performance block transfer rates

MXI-2 The second generation of the National Instruments MXIbus product line.

MXI-2 expands the number of signals on a standard MXIbus cable by

including VXI triggers, all VXI interrupts, CLK10, SYSFAIL*,

SYSRESET*, and ACFAIL*. MXI-2 also defines higher-performance data

transfer protocols.

MXIbus Multisystem eXtension Interface Bus; a high-performance communication

link that interconnects devices using round, flexible cables

MXIbus System

Controller

A functional module that has arbiter, daisy-chain driver, and MXIbus cycle

timeout responsibility. Always the first device in the MXIbus daisy-chain

N

NI-488 or NI-488.2 The National Instruments software for GPIB systems

NI-DAQ The National Instruments software for data acquisition instruments
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NI-VISA The National Instruments implementation of the VISA standard; an

interface-independent software that provides a unified programming

interface for VXI, GPIB, PXI, TCP/IP, and serial instruments

NI-VXI The National Instruments bus interface software for VME/VXIbus systems

Non-Slot 0 device A device configured for installation in any slot in a VXIbus mainframe

other than Slot 0. Installing such a device into Slot 0 can damage the device,

the VXIbus backplane, or both.

O

Onboard RAM The optional RAM installed into the SIMM slots of the MXI-2 board

P

PCI Peripheral Component Interconnect. The PCI bus is a high-performance

32-bit or 64-bit bus with multiplexed address and data lines.

PXI PCI eXtensions for Instrumentation; an open implementation of

CompactPCI that adds electrical features that meet the high-performance

requirements of instrumentation applications by providing triggering, local

buses, and system clock capabilities. PXI also offers two-way

interoperability with CompactPCI products.

R

register-based device A Servant-only device that supports VXIbus configuration registers.

Register-based devices are typically controlled by message-based devices

via device-dependent register reads and writes.

Resman The name of the National Instruments Resource Manager in NI-VXI bus

interface software. See Resource Manager.

Resource Manager A message-based Commander located at Logical Address 0, which

provides configuration management services such as address map

configuration, Commander and Servant mappings, and self-test and

diagnostic management

retry An acknowledge by a destination that signifies that the cycle did not

complete and should be repeated
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S

s seconds

Servant A device controlled by a Commander; there are message-based and

register-based Servants

Shared Memory

Protocol

A communication protocol that uses a block of memory accessible to both

a client and a server. The memory block operates as a message buffer for

communications. This is unique to register-based interfaces such as VXI.

SIMM Single In-line Memory Module

slave A functional part of a MXI/VME/VXIbus device that detects data transfer

cycles initiated by a VMEbus master and responds to the transfers when the

address specifies one of the device’s registers

slave-mode operation A device is in slave mode it if is responding to a bus cycle.

Slot 0 device A device configured for installation in Slot 0 of a VXIbus mainframe. This

device is unique in the VXIbus system in that it performs the VMEbus

System Controller functions, including clock sourcing and arbitration for

data transfers across the backplane. Installing such a device into any other

slot can damage the device, the VXIbus backplane, or both.

SODIMM Small Outline Dual In-line Memory Module

statically configured

device

A device whose logical address cannot be set through software; that is, it is

not dynamically configurable

SYSFAIL A VMEbus signal that is used by a device to indicate an internal failure.

A failed device asserts this line. In VXI, a device that fails also clears its

PASSed bit in its Status register.

SYSRESET A VMEbus signal that is used by a device to indicate a system reset or

power-up condition

System RAM RAM installed on your personal computer and used by the operating

system, as contrasted with onboard RAM, which is installed on the MXI-2

board
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T

trigger Either TTL or ECL lines used for intermodule timing

TTL Transistor-Transistor Logic

U

user window A region of PCI address space reserved by the PCI-MXI-2 or PXI-8320 for

use via the NI-VXI low-level function calls. MapVXIAddress() and

viMapAddress use this address space to allocate regions for use by the

VXIpeek(), viPeekX, VXIpoke(), and viPokeX macros.

V

VIC VXI Interactive Control Program, an optional part of the NI-VXI bus

interface software package. Used to program VXI devices, and develop and

debug VXI application programs

VISA Virtual Instrument Software Architecture. This is the general name given to

VISA and its associated architecture. The VISA specification, standardized

by the VXIplug&play Systems Alliance, defines an interface-independent

I/O API for VXI, VME, GPIB, GPIB-VXI, Serial, and TCP/IP. It is the

standard on which modern instrument drivers rely for I/O.

VISAIC VISA Interactive Control utility, a part of the NI-VISA software.

It provides access to all I/O resources and all VISA functionality

interactively, and is a convenient starting point for program development

and learning about VISA.

VME Versa Module Eurocard or IEEE 1014

VMEbus System

Controller

A device configured for installation in Slot 0 of a VXIbus mainframe or

Slot 1 of a VMEbus chassis. This device is unique in the VMEbus system

in that it performs the VMEbus System Controller functions, including

clock sourcing and arbitration for data transfers across the backplane.

Installing such a device into any other slot can damage the device, the

VMEbus/VXIbus backplane, or both.

VXIbus VMEbus eXtensions for Instrumentation
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W

Word Serial Protocol The simplest required communication protocol supported by

message-based devices in a VXIbus system. It utilizes the A16

communication registers to transfer data using a simple polling handshake

method.

write posting A mechanism that signifies that a device will immediately give a successful

acknowledge to a write transfer and place the transfer in a local buffer. The

device can then independently complete the write cycle to the destination.
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Add Device Wizard, B-4

application development, 3-1

configuration, 3-2

debugging, 3-10

device interaction, 3-4

NI-VXI API programming notes, 3-8

optimizing large VXIbus transfers, 3-7

programming with VXI, 3-6

example programs (table), 3-7

shared memory, 3-8

B
bulkhead cables, B-7

C
cables

bulkhead cables, B-7

cable connection for MXI-2, 2-3

CLK10 signal, B-7

common questions, B-1

ComponentWorks, 1-6

ComponentWorks++, 1-6

configuration, 3-2

configuration EEPROM is invalid message, B-6

conventions used in the manual, xi

customer education, C-1

D
debugging your application, 3-10

default settings

PCI-MXI-2/PXI-8320

hardware settings, A-1

MAX settings, A-2

VXI/VME-MXI-2

hardware settings, A-4

MAX settings, A-7

device interaction, 3-4

documentation

flowchart for using manual, 1-1

how to use documentation set, x

related documentation, xii

driver window, B-8

D-size mainframes with P3 connector (note), 1-3

dual-ported memory, B-8

H
hardware configuration, 2-1, 3-2

hardware description, 1-3

P3 support, 1-3

PCI-MXI-2 interface board, 1-3

PXI-8320 circuit board, 1-3

using VME devices, 1-4

VXI/VME-MXI-2 module, 1-3

hardware installation, 2-1

hardware settings

PCI-MXI-2/PXI-8320, A-1

VXI-VME-MXI-2, A-4

how to use documentation set, x

I
installation and configuration, 2-1

hardware configuration, 2-1

hardware installation, 2-1

configuring more than one device as

system controller (caution), 2-2

connecting MXI-2 cable, 2-3
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electrostatic discharge (caution),

2-1, 2-2

mainframe extender, 2-2

PCI-based MXI-2 interface, 2-1

software installation, 2-3

completing installation, 2-4

procedure for installing software, 2-3

verifying system configuration, 2-5

L
LabWindows/CVI, 1-6

LEDs on front of VXI-MXI-2 or

VME-MXI-2, B-7

logical address in multiple-mainframe

system, B-8

Logical Address Wizard, B-8

M
mainframe extender, installing, 2-2

MAX

changing configuration settings, 2-1

default settings

PCI-MXI-2/PXI-8320, A-2

VXI/VME-MXI-2, A-7

overview, 1-5

Measurement and Automation Explorer. See

MAX

memory, shared and dual-ported, B-8

MXI LED, B-7

MXI-2 interface kit. See PCI-based MXI-2

interface

MXI-2. See PCI-MXI-2/PXI-8320

MXIbus system controller, 1-3

N
National Instruments application software, 1-5

National Instruments Web support, C-1

NI Developer Zone, C-1

NI Spy utility, 1-5

NI-VISA software

example programs (table), 3-7

overview, 3-1

NI-VXI API

compatibility layer options, 3-9

compiler symbols, 3-8

installing, 3-6

overview, 3-1

programming notes, 3-8

NI-VXI compatibility layer, 3-1

NI-VXI software

determining which version is

installed, B-4

example programs (table), 3-7

overview, 1-4, 3-1

O
old utilities, installing, B-3

optimizing large VXIbus transfers, 3-7

P
P3 connector on D-size VXI mainframes

(note), 1-3

PCI-based MXI-2 interface

common questions, B-1

hardware description, 1-3

installation, 2-1

overview, 1-2

requirements for getting started, 1-2

software description, 1-4

National Instruments application

software, 1-5

VME users, 1-4

PCI-MXI-2/PXI-8320

connecting cable properly, 2-3

determining serial number and hardware

revision, B-4

hardware description, 1-3
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programming with VXI, 3-6

programming. See application development

PXI-8320. See PCI-MXI-2/PXI-8320

R
related documentation, xii

requirements for getting started, 1-2

Resman

performing startup Resource Manager

operations, B-5

running, B-3

testing your system, B-5

troubleshooting hangups, B-6

when to use, B-3

Resource Manager. See Resman

rugged chassis, B-7

S
settings. See default settings

setup. See installation and configuration

shared memory, 3-8, B-8

software description

National Instruments application

software, 1-5

NI-VXI bus interface software, 1-4

software installation, 2-3

completing installation, 2-4

procedure for installing software, 2-3

startup Resource Manager operations, B-5

SYSFAIL LED, B-7

system controller

configuring more than one device as

system controller (caution), 2-2

optional MXIbus system controller, 1-3

system integration, by National

Instruments, C-1

system requirements, 1-2

T
T&M Explorer, B-1

replacement by MAX, B-2

technical support resources, C-1

U
user window, B-8

utilities

questions about, B-1

V
VIC utility, B-1

overview, 3-4

VICtext, B-1

VISAconf utility, B-1

VISAIC utility, B-2

overview, 3-4

VME devices

adding with Add Device Wizard, B-4

configuration considerations, 2-2

using with PCI-based MXI-2

interface, 1-4

VME-MXI-2. See VXI/VME-MXI-2

VXI (VME) LED, B-7

VXI programming, 3-6

VXI/VME-MXI-2

hardware description, 1-3

hardware settings, A-4

LEDs on front panel, B-7

MAX settings, A-7

VXIedit utility, B-1

VXIinit, B-1, B-2

VXIplug&play specifications, 1-5

VXItedit, B-1
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